Business

ASCENDER.

ELEVATING TECHNOLOGY SOLUTIONS

ASCENDER GUIDES

A ASCENDER.

ELEVATING TECHNOLOGY S5OLUTIONS

pmis_initial setup processing existing_users

2026/01/28 02:29

pmis_initial_setup_processing_existing_users



Business

2026/01/28 02:29 ii pmis_initial_setup_processing_existing_users



Business

Table of Contents

pmis_initial_setup_processing _existing _USers .................cccoiiiiiiii i [
QuickGuide: PMIS - Setup and Processing for Existing Users ............cccccciiiiiiiiieeee,

2026/01/28 02:29 iii pmis_initial_setup_processing_existing_users



Business

2026/01/28 02:29 iv pmis_initial_setup_processing_existing_users



Business

QuickGuide: PMIS - Setup and Processing for
Existing Users

This guide provides existing users with the necessary steps to begin the next year (forecasting)
process in the Position Management Information System (PMIS).

Set up Next Year Human Resources Payroll Tables

1. Export next year payroll.

2. Export next year PMIS.
Position Management > Utilities > Export PMIS Tables
This utility is used to export current and next year position management tables for all pay
frequencies including PMIS District Options. The export includes active/inactive positions and

supplemental positions.

You can use the Position Management > Utilities > Import PMIS Tables page to import the
tables.

Note: If data is changed after the export and then imported, those changes are not included.

B mEimmERe 0 ResioManagen
[ |-

Export Filename: db001904_PMIS_1101200 rsf

Enter the Password to be used for the Archive: [-----4

Export position management tables:
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Field Description

Export File Name This field is preset and display only. The export file name has the format
dbcccddd PMIS_mmddyyyy.rsf, where cccddd is the county-district
number, PMIS indicates position management, and mmddyyyy is the
current date.

Enter the Password
to be used for the |Type a password for the exported file.
Archive

O Click Execute. The tables are exported and a message is displayed indicating that the export
process was completed successfully.

3. Clear next year payroll tables and copy all tables from current to next year.

Log on to the current year pay frequency.

CAUTION: Before moving forward, keep in mind that this step clears all manual
changes that were made to next year salary tables.
Perform the following two processes:

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

This tab is used to clear:

o All next year tables for all pay frequencies regardless of the pay frequency to which

you are logged on.
o Only EQY accrual data.
o Only next year payroll budget data.

Individual frequencies cannot be selected for deletion.

Note: EOY accrual reversals must be created and interfaced to Finance before clearing next
year tables or EOQY accrual data only.
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CLEAR MEXT YEAR TABLES COPY CURRENT YEAR TABLES

(] Clear EQY Accrual Data Only [ Clear NY Payroll Budget Only

Accrual Calendar
Extra DIJ["' pﬂv

Houwrly [ Daily Salary
Job Code

Local Annual Salary
Midpoint Salary
School Calendas
State Minamum Salasy
Substitute Salary

Workers” Compensation Rates

Employes Bank Record

Employes Deductions

Empleyes Extra Duty
Employee Job

Employes Pay

A, M
W W'

0o000000000000ooooaao

Emplovee Pay Distributson
EOW Accrual Calendar

EOY Accrual Data

EOY Accrual Fund Decrement
MY Payroll Budget

Clear next year tables:

Field

Description

Clear EOY Accrual Data
Only

Select to clear the EQY accrual data records only. All other next
year data is left intact.

Clear NY Payroll Budget
Only

Select to clear the next year payroll budget records only. All other
next year data is left intact.

Note: If an option is not selected, all displayed next year tables for all pay frequencies
(regardless of the pay frequency to which you are logged on) are cleared when you click

Execute.

All available next year payroll tables are displayed on the left side of the page. Select the tables
to clear. Use the arrow buttons to move the selected tables from the left side to the right side of

the page.

O Click Execute. A message is displayed indicating that the next year records have been

cleared. Click OK.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables
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This tab is used to copy all tables or selected tables as next year records for the
corresponding next year frequency (e.g., CYR = 6, NYR = F; CYR =5, NYR = E; and CYR = 4,
NYR = D). The tables are copied from all current year frequencies to all next year frequencies
(except the School Calendar table). The School Calendar table header is only copied for the
frequency to which you are logged on. To copy the school calendar for another frequency, log
on to the other frequency and copy the School Calendar table. The calendar itself is not
copied, only the calendar code and calendar description. Type the year in the Start Year
field and the beginning month in the Start Month field to begin the process of building the
next year calendar.

CLEAR MEXT YEAR TABLES COPY CURRENT YEAR TABLES *

Accrual Calendar [ ] i | : J !.
Extra Duty Pay [ ] :
Haurly f Dady Salary [ | i
Job Code [ ] :
Local Annual Salary [ ] i
Midpaint Salary [ ] i
School Calendar | | §
State Minimum Salary L | i
Substitute Salary ( | i
Wiorkers' Compensation Rates [ ] ]

Copy current year tables:

All available current year tables are displayed on the left side of the page. Select the tables to
copy. Select the corresponding check boxes to select a table. At least one table option must be
selected.

o Select  next to the table(s) to copy.
o Select [ again to clear the selected check box.

O Click ¥ if you do not want to copy the entire table, but want to include specific data from a
table.
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Notes:

o Only the selected tables are processed.

o If the tables are copied multiple times and the record in the current year does not
exist in the next year, the new record is inserted in the next year.

o |If the tables are copied multiple times and a description is changed in the next year
but not in the current year, the description is replaced by the description in the
current year table.

O Click Select All Tables to select all current year tables to copy to the next year.

O Click Execute. A separate preview report is displayed for each selected table.

O Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

4. Copy current year staff to the next year payroll.

Log on to the current year pay frequency.

Payroll > Next Year > Copy CYR Staff to NYR

[ e J[ e [ ome ]

Parameters
Pay Status:
@) Active () Inactive () Beth Primary Campus: [ AlL ~|  Payoff Date: [:]5
Pay Campus: [All “] Frequency: 16 MONTHLY CYR V]
|Pay Type: | E Exclude Substitute v Contract Begin Date: | ~|  Salary Concept: (an ~|
Job Code: TAL ~] Cantract End Date: [ ¥| ExractiD: ( ~|
2 [
Acarual Code: | Al v) Contract Months: ]: EmployeeNbe [ 3
R .
Prior Yr Emp Date: | 00-00-0000
Options

[]include Employees with Termination Date
Dlnactivate Records when Creating NY Tables

Mext Year's Funding Code

Mumber of Remaining Deductions D

D Preview changes

Complete the following:
U In the Pay Type field, select E - Exclude Substitute.

O Under Options:
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o Select Include Employees with Termination Date.
o In the Next Year’s Funding Code, type the fiscal year that exists in Budget.

O Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

O Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that
were copied is displayed. Click OK.

O Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

5. Update next year payroll tables.
Update the following tables as needed:
O Salaries

o Personnel > Tables > Salaries NYR > Local Annual - Only contracted employees
Personnel > Tables > Salaries NYR > Hourly/Daily - All contracted, noncontracted, and
hourly employees

Personnel > Tables > Salaries NYR > Extra Duty

Personnel > Tables > Salaries NYR > State Minimum

Personnel > Tables > Salaries NYR > Midpoint

[¢]

o

[¢]

[¢]

Log on to the next year pay frequency.

O Tax/Deductions - Verify that you are logged on to the next school or calendar year (2024).
The current and next year tables are shared. Any current year changes affect the current year
payroll. These fields are updated when calculating employee taxes and benefits for budget
purposes; therefore, they must exist in the next school year.

o Payroll > Tables > Tax/Deductions > FICA Tax

o Payroll > Tables > Tax/Deductions > Unemployment

o Payroll > Tables > Tax/Deductions > TRS Rates

o (If applicable) Payroll > Tables > Salaries > Workers’ Comp

O Job/Contract - Add or update job codes as needed. If any job codes are added or updated,
indicate the accrual code and workers' compensation code if applicable.

o Personnel > Tables > Job/Contract NYR > Job Codes
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O Calendars - This step must be completed prior to continuing to the next step.

o Personnel > Tables > Workday Calendars > School Calendar - All employees must have a
school calendar.

6. Set up next school year pay dates.

Log on to the current year pay frequency.
Payroll > Tables > Pay Dates

Although the current year pay dates are used at this time, the next year pay dates can be
created. The next year pay dates must be set up prior to rolling positions to the next year PMIS.

E

Delete SshoolYear  BavDate Bepin Datg EndDpte  IBSMooth TWC Quarter Print Alternate Sddress
o

2024 | 0232024 | [ 0s-02-2024 | [ 0m-32-2024 | || o= |

2024 [ 07-25-2024 ) [07-01-2024 | [07-31-2024 | [ 07 ]

2024 [ 06-24 zuz-:] [ca 01- 2024 ] |_ 06-30-2024 ] [ [3 ]

2024 [0524.2024 | [05.00.2024 | [0532.2024 | [ 05 |

2024  [o0425-2024 | [04-01-2024 ] [ 04302024 ] [ 04 ]

2004 [ 03252024 ) [o03-01-2024 | [ 03312024 | [ 03 |

2024 | oz-23-2024 | [ 02-01-2024 | | 02-29-2024 | | o2

2024 [o125-2024 ) [o0101-2024 ) [o231.2024 ] | o1

2023 [ a2z202023 ) [12-01-2023 ) [a2302023 ] [ a2

2023 || 10-25-2023 | | 10.00-2003 | | 10-31-2083 | [ 10

2023 [oo252023 ) [oo0r2022 ) [oo302023 ] [ o2

2023 | 08.25-2023 | [ 07-08-2023 | | 08-04.2023 |

)
)
J
2003 [12a2023 ) (1012003 ) (32023 ] [ 11 ]
J
]
J
J

|
2023 [or25-2023 ) [os-10-2003 | [orov2023 ] [ o7

2023 | 06-23-2023 | | 05-06-2023 | | o6-09-2023 | [ o6
. 2 (v ] [Last] 9 Add
— ,

Selected Pay Date

¥
DUUDDUDUUUDDUUDE

HUHEHEEBHEEBHE

Addjustmant Mor Date Pay Run Interface User ID

Mo Rows
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Set up District Administration Options

1. Update Position Management options.

District Administration > Options > Position Management

This page is used to create and maintain Position Management options including the types of
calculations that should be used in Position Management and the specified default values to
be used for certain types of Position Management transactions. These options are not
typically changed throughout the school year.

District Options

Use PMIS:
Unergplanment Eligibile:
FICA [ Medicare Eligible

Use Forecast Conversion Tables

Allew CYR Position Description Changées (Admin only)

Allow Forecast Position Description Changes:

Payment Options

Round Salary to Nearest Whole Dollar.

During CIC Calculation. Pay One-Time Supplement

Employee Must Be Assigned a Position Prior to Creating Payroll Record:

Display Options to Ignare Pet of Day and Pct of Year for Position Reconds:

O 88

Current Year:
Hext fear: E]
Minimum Foundation Yoear
Default Position Record Statws: l'u-' - Macant( st position infa, ready to L emp) U‘J

O Verify that the following fields are completed and accurate:

o Current Year
o Next Year

o Minimum Foundation Year - Type the four-digit current or next school year in the YYYY
format to allow the system to select the corresponding tables to calculate the state
minimum salary amount. If this year matches the current year value, the current
Personnel state minimum table is used. If this year matches the next year value, the next
year Personnel state minimum table is used.

2. Update the current and next year first pay date codes.

Use the following pages to establish the current and next year first pay dates and codes.
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District Administration > Tables > PMIS > First Pay Date > Current Year

This tab is used to create and maintain a list of codes associated with current year pay dates
to be used for Position Management. The codes are used:

o To establish an association between a table ID and a starting pay date.

o To establish a start date for a new teacher so that a new teacher can be paid over 13
months.

o To determine the first pay date of the new school year when calculating the amounts
already paid to an employee.

o To calculate the amount to be paid to an employee during the change-in-compensation
processing.

o To update the payroll data with the data in the forecast records, and to move the
forecast data into the current position records.

In this example, the first pay date codes begin with J, A, or S to represent the first pay date
month (July, August, or September). The subsequent two characters represent the calendar
code. Codes can be a maximum of three characters and any letters should be uppercase.

CURRENT YEAR HEXT YEAR

Starting Pey Date Lude[: FleT gy |

Delete  First Pay Date Code  First Pay Date Descrintion

) E=n )
(a7} [Ga-z5-2 IG5 ]
=) E= )
[aF1 ] [ce-2s-20 ] (197 DAYS CN DIRECTOR |
(a0 ) (08-25-20 [220 j
[arp ] [08-25-2 J
T )
v )
[ao1 [ ]
] | )
) )
) & )
e )  [Emwn )
F) & )
E) &

(16 : o7

o R 2

]
|

Complete the Current Year and Next Year tabs. The Current Year tab represents the first pay
dates for the current school year, and the Next Year tab represents the first pay dates for the
next school year.
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District Administration > Tables > PMIS > First Pay Date > Next Year

CURRENT YEAR HEXT YEAR

Starting Pay Date L'uur[: | Ristrisvi | [
Delete  First Pay Date Code  First Pay Date Description
[a17 ] [o8-25-2c ) [210DAYS 15T OF AUG STAR ]
&) @E==s )| )
[aec ] [o8.25-20 :j [EaRLY CHECK-13 ]
(A1) 08-75-20 ) (197 N DIRECTOR |
[ ] [oe-2520 ] | J
) @Es )| )
) @Es= | )
(s ] [z ] | ]
[ros ] [0a-25-2¢ ] (195 Davs |
apf ] [l ] | )
[rre ] [0a-25-26 } [ ]
[z | [07.25-20 ] [ ]
s ] ([07-252¢ ) [TEAcHERS ULy START ]
E) @m= )| )
[er ] (72522 ] [ ]
[ ] [or-528 ) (zz0Davs |
[iF ] [o7-2520 ] | J
o) @=n )| )

3. Update the forecast conversion data.

o Prior to completing this step, the calendars and pay dates must exist in the next
year payroll files.

District Administration > Tables > PMIS > Forecast Conversion

This page is used to create forecast data for the next year's records. This table maintains the
data conversion information by the First Pay Date Code for the Calendar Code, Begin
Date, End Date, Payoff Date, Max Days, Number Of Days Off and Actual Payments.
These fields should be updated with the dates to be used for the next school year. From this
data, the appropriate calendar data is located and the following calculation is performed: The
Local Begin Date is subtracted from the Local End Date, and then the Number of Days
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Off is subtracted resulting in the number of Actual Days.

FORECAST CONYVERSION
I I
Eifst Pa. Cabaidie Exta Daity it Py Lkl Le<al Last b OF Actual Actual
Delsta Cate Coge Cods Coile Eiate Descration Begin Date End Date Pay Dats Mas Darys Crars Ot Days Paymerts
@ E ) Eown) Fomd) @zl (W) ( | — | —
( Ji )i [ )i [ 23 ) [aaaead ) a3 [ an) | ] 177) 1)
2[5t Ig a2 1t | Ji TEACHER+10DAYS  [o7.26-2023 | [0531.2024 | [omza2024 |§ [ 193] [ oo | 193] | 12]
B @ C Gonn) Goen) @aEn 1 (5 ( ) @) | )
E )i E )i C 1 mooss ) Eaen]) Easa )i ) | | — | —
E ) B C ) Eam) G i (o) ) ) =)
B o ¥ o8 | Ia [o703 2023 ] [os 4 ) [os2ezoas T8 [ 226) | | 2] [H]|
fe__Jo (s J¢ [ Ji  TEACHERS Ay START (07032023 ] [o6 202024 ) (pe2a 2024 ]y I] ( ] 2ad] | 1]
(2 J8 Bz_J8 [ )i (33023 ] [p620 2024 ] [eeaazo2s T4 3] [ ] [ 256) | 1)
[ J8 [Re__ Ji | Ji (07102023 | [e6a3eoed | (o7saeed |3 [ 210) | J Iu] [ 1
[ros  Jg [oa ]i | Ji 29504 [o7.25.2023 | [o6-0a.2024 ] [or-25.2024 J8 [ 195] [ | 98] | 12]
B BB C Tres) Eaen) @Eaa ) () ( N — )
8 B B | )i ) Eoen) esa i 99 59) ) |
E ) E ) C ) Eren) @ () 9 ) B|
( Ji [ )8 [ s [ ] ( ][ h 9 wo) '] [ 1)
( i | Ji [zt [ IR ] It 9 | og) | 9 | 1
| | | TR | [ I JE It | 9 | J q 1]
( Ji | I N E ] & ] E= IHE 9 [ ] 9 [ 1)
B | i Ji eIt [ ) 1 C i | of | J 1 g | 12
( H | (IR | [ J L nNE It g [ | | 9 | 12
S 1 Ji e ___Ji [ ][ 1 I 9 ) [ g [ 1]
| Ji | [ EC | [ ] ] C I 9 ][ 7 [ 1)
® i | Ji = [ il | ] E i | o] 0] | 9 | 12
[ I ]t e [ [ [ 1 (9| o) [ 9 [ 1)

For each pay date code, complete the fields on the page. The next year begin and end dates
must match the new calendars in the next year payroll files, and the payoff dates must exist in
the pay dates table for each first pay date code.

This process updates the table and replaces the mass updating process that is done in the next
year payroll.

The Days Off field is used to reduce the days worked without tying back to unavailable days on
a calendar. For example, a district police officer may work every day (or have the potential to
work every day) but may have a certain number of days off per year that can be taken at any
time.

during the year, be sure to set up a new first pay date code using that calendar

o Reminder: If you set up a new calendar code in Position Management at any point
code and add that information to this table.
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Perform PMIS Maintenance

Log on to the next year.

1. Delete next year PMIS.

Position Management > Utilities > Mass Delete Forecast Positions

e e e |
Select Positions only (P). Supplements only {S) or blank for ALL: D
Select Fosition Statuses or blank for ALL: [ ] :]
Select Position School Years or blank for ALL: [ ] :]
Select First Pay Date Codes or blank for ALL: [ ] :]
Select Extra Duty Codes or blank for ALL: [ ] :]

Select Positions or blank for ALL:
{Includes ALL billets for selected positions [ ] :]
Blank for ALL mot processed when Positions/Billets selected)

Select Fositions/Billets or blank for ALL: ( ] :]

Selact Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL mot processed when Supplements/Billets selected)

Selact Supplement Positions/Billets or blank for ALL: [ ] :]

Year: M

O Leave all fields blank and click Execute. A list of processing reports is displayed.

[ Process h{ﬂ ]
Processing Reports
Selact Report Mame
Mass Delete Forecast Positions Process Error Listing
hass Delete Forecast Positions by Employee Mame
Mass Delete Forecast Positions by Campus
Mass Delete Forecast Positions by Position/Billet
[ Generate Reports ] [ Select AlL ] [ Umnizelect All ]

O Select the reports to generate, and print or save the reports.
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O Click Process to delete the forecast records. You are prompted to create a backup.

2. Copy current year positions to the next year.

Position Management > Utilities > Create Forecast Positions

Include Proposed Positions:

Move Forecast Conversion Actual Payments to Position Max Payments:
{Also includes remaining payments if Position occupied)

Mowve Forecast Conversion Actual Payments to Supplement Max Payments:
Reset Supplement Amounts based on Extra Duty Code Table Default Amount]
Mowve Forecast Conversion Max Days to Supplement Max Days:

Move Supplement Max Days to Supplement Extra Days (ocoupied only):

EPRREE 8 O

Move Supplement Max Payments to Supplement Remaining Payments:

If an LEA has the Percent of Year field set to less than 100% of the stipend

amount on the Position Management > Maintenance > PMIS Supplement Modify >

Position Record tab, they should consider whether or not to select the Reset

Supplement Amounts based on Extra Duty Code Table Default Amount
é ., field.

If the Reset Supplement Amounts based on Extra Duty Code Table Default
Amount field is selected, the amount on the supplement position record is reset to
match the amount on the extra duty table.

O Select all fields and click Execute. A list of processing reports is displayed.

[ Process h ncel l

Processing Reparts

Select Report Mame

Create Forecast Positions Process Error Listing
Create Forecast Positions by Position/Billet

[ (zenerate Reparts l [ Select All l [ Unselect AlL

O Select the reports to generate and print or save the reports. Verify any errors and make
corrections as needed.
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O Click Process. You are prompted to create a backup.

3. Update the fiscal year for distributions.

Prior to completing this step, verify that the new year budget is initialized in ASCENDER.
Position Management > Utilities > Update Fiscal Year by Fund

O Select the fund/years to be incremented. This process increments the position distribution
fiscal year by 1.

[ Retrieve l [ Execute h

UPDATE FISCAL YEAR BY FUND

Increment Fiscal Year by 1

Increment Fund/Year

 Click Execute.

4. Generate the Position Listing by Campus Report.

Position Management > Reports > PMIS Reports > HRS8050 - Position Listing by Campus

Generate the Position Listing by Campus Report from next year Position Management to
determine the following:

o If any employees need to be moved to a different position.
o If you have vacant positions you need to update with employee information.
o If you have any supplemental positions that need to be updated for stipends.
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M4 » M

Date Run: Position Listing by Campus Program: HRSB0S50

Cnity Dist: ISD Page:1of 11

Campus

Position Billit Hbr Position Description Freq Emp Hbe Employee Hame Pct Worked

EXTRADUTY 00002  FROZEN CARRYQVER 3 000026 0.00 %
PTEACHER 00205  ENGLISH g 000028 100.00 %
ATHLETICS 00015  BASKETBALL ASST 3 000027 0.00 %
ATHLETICS 00098  TRACKASST 3 000027 0.00 %
ATHLETICS 00113  VOLLEYBALL ASST 3 000027 0.00 %
EXTRADUTY 00005  FROZEN CARRYQVER g 000034 0.00%
EXTRADUTY 00006  FROZEN CARRYOVER 3 000041 I 0.00%
PTEACHER 00606  SOCIAL STUDIES 6 000041 100.00 %
PCAMPUS 00114  AIDE 3 000048 100.00 %

5. (If necessary) Transfer positions from one first pay date code to another.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date
code when a new hire employee on a 13-month pay date cycle needs to convert to a regular
12-month pay date cycle.

Save

FIRST PAY DATE FORECAST CONVERSION

Starting Pay Date Cc\de::] l Retrieve ] l Print
Delete From Start Code From Start Code Description To Start Code To Start Code Description
ATC i 187 Days (25 pmts) H 187 Days (24 pmt=)
CO i July Payroll SNC i i

Add

6. (If necessary) Update regular and supplemental positions.

Note: If your LEA comes across a situation where teachers are not being captured in the
ASCENDER Student system for grade reporting or scheduling, contact your regional ESC
consultant for guidance.
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Position Management > Maintenance > PMIS Position Modify or PMIS Supplement Modify

Dty Bitlat SShYR  Descripton STl Freg Emp N First Naims Mt el Lt Nard Gen “
[@] DOOK 24 [TEACHER | F
2 10 O | .
8] 010 024 [ ARTS & FL ] £ 001179 WANDA MARIE VWILLIAMES
0 00103 | 2024 [aATS ] 'y F DDLIS5  WENDY CHARLES WILSOM
0 010 2 [arrs ] F O00TIE  MELISEA MEW EMPLOYEE
o] i i J'-'r.:- HALF T ] ...... ITHE D o

If working on the Distribution tab, you must select an account code from the
autosuggest drop down in the Account Code field versus typing in the full
account code in order to validate against the grant code table.

If necessary, use one of the following options to vacate an employee from a position:

O Option 1: It is best practice to use the Position Management > Utilities > Vacate Employee
from Forecast Positions page to vacate a position.

Typically, when an employee decides to leave the LEA at the end of the year, the employee is
paid off in payroll at the end of their contract; therefore, no additional action is necessary for
the current year. However, in the forecast records, the employee must be removed from all
existing positions.
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VACATE EMPLOYEE FROM FORECAST POSITIONS

Emplape [0@0?5

o ———

Wacate | Dotads AcceptChgs  PusitionTyps  Position Number Pesition Description Balet  SchYR Job Codde St
o L4 PEBAADLT LEAD WELLMESSWE FACIUTATOR | 00001 ~ 2035 AZ17. LEAD WELLNESS FACLITATOR A
o] ] s ATV TRAVEL 00000 2026 A

eupart Infarraton

Job-Code: [A217 - LEAD WELLNESS FACILITATOR ] Primary lobc [f]  Percent Day Employed Percent Year Employest

Pay Concept sadpeint Pary Grade: [:-_l-u Contracted omp  State Stop E-] Begin Date: [07-15 _'ugaj End Date: [U-b 13-202% | Payolf Date [-ug?::;:_",

o Dy 210.0| Dawe O ) Mo Doy Employed: 21000 Howrs Per Doy, T FosaryTiaily feate: B84 688 | Actusl Salary: @0 784 00 Remaining Paymant:: 12

Pramary Cagut: (003 - 503 School Dept: (0] Colendar Code: (38| TRS Member P (00 - Professional stast | tner Eligas: 7)
(Distribation bvioimaton
Ativity Code Aroourt Code Grant Coda Weorkers' Comp [Expense 373 Ergiayer Contribafion Parcent Amaurt Dp At
- (199136119 00-003-511000 | ) & 5 70000 (65«0
o [101-385-6115.60-938- 555000 ] A K® 30000) 24I38E0
Totals:

L0 Qg EQLT8400

o Retrieve the employee's position record.
o Select the Vacate check box for each position.
o Click Save.

O Option 2: Use the Position Management > Maintenance > PMIS Forecast Change page (only
available in the next year payroll) to change an employee from one position to another. A list of

the employee's existing positions is displayed with a section to either enter a new position or
vacate a position.

Job Code: Seatus
1000 - TEACHER A

Primary Job Percent Doy Emgloyed EI Percent Year Employed £ sruilate
L P Pay Step 1 Schedule Dg Saate Step E] Begin Date: [08-03-2023 | End Date [05-23-2024 | Payolf Date
Ve D ON '.':.- Days Emgloved: 183 00 Houwrs Per Day HourlwDaiy R 204 011 | Acwual Sslary: 538040

0 Remas
Primary Campus: [001 - D01 School J: Dert D'.‘:..m:u- Code: 10 TRS Member Pos: (17 - Teacher, borarian incr Pay Step £
Drstribution infanmation
Desete Artivity Code Astount Code Grart Code Wiorkers' Comp Expense 373 Employer Contribution Percent Arnteant Dup Acct
B |z'_- Base Salary v] |".3~:- 11-6119.00-001-41 1000 A 538000
Toxati 100,000 5380400
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7. Generate the PMIS/Payroll Discrepancy Report.

Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll Discrepancy Report

Generate the PMIS/Payroll Discrepancy report to determine if there are any active employees
not assigned to a forecast position. Below are some examples of the PMIS/Payroll Discrepancy

report:
Dot P PMIS. ] Paryeoll Discropancy Report Program: HRSEGL
Criby Dt 0 Prage: Tl 9
b Ll Companson
ot
Freg T Provatin M el Dscrption g M Ernploryn Mo Mrvenm
E P PSAINR 00007 ADMBESTRATIVE [ L] Does: roct harve the same jobrcodes or exira duty
codes in TR Paryecl
E P PSAIND 00007 DR OF TECHMOLDGY o0oess Cots nat harve the same job codes o exir duty
oodes in TR Payecl
E P PSATIOE 00007 TRANSPORTATION COORD [ F ] Do rict b S s jobs codes or endra duty
codes i OV Payscl
E P PSAING 00001 BURSINESS MANAGER DOCEES Doss not have e same joboodes o exirs duty
codes in CYR Payscl
E P PSATIE 0000 DIRECTOR ATHLETICS [ ie o] Do rict havs S savmas jobs codes o endra duty
oodes i CYR Payecl
E P PSINT CO001 PEIMS COORDINATOR ooctag Coes rect harve tha same jobcodes o extra ety
codes in OV Payecl
E P PSRN0 00007 FACILITIES CeRECTOR 000872 Does nct have the same job oodes or exdma duty
Date Run: PMIS | Payroll Discrepancy Report Program: HRS8054
Cnty Dist: 5D Page: 1 of 1
Employes Level Comparison
Pos Billat
Frog TYP Position Nbe Hbr Dwacription Emp Mbr Employes Mama Mosango
F P PCAMPUS DO300 PRINCIPAL 000012  ADKINS, ALEXANDER LYNN Inactive in CYR Payroll
& 001140  BUSMGR, IMA Active emp not assigned 1o Forecast Position
6 000&31  POER. PACER P Active emp not assigned 1o Forecast Posithon
] 001058 WHARTONM, TYLAR DEMAA  Active emp not assigned to Forecast Position
6 001120 WILLLAMS, WENDI IRENE Active emp not assigned 1o Forecas! Position
[ 001134 WYNN, WYOMING Active emp not assagned 1o Forecast Posdtion
] 001135 YARBROUGH, TACHARY KAY Active emp nol assigned to Forecast Position
8 001138 YOUMNG, ZEB MARTIN Actrve emp nol assigned Lo Forecast Position
L] DO1138 ZAPATA. ZOMA ASHLYMN Actrve emp nol assigned 1o Forecas! Position
Total Number of Employees 9
End of Report

8. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last

year.

O It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:
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[ Save ] [ Create Report ] [ Delete ] [ Reset ] Year; C e

PMIS Position/Distribution Export File Auta Select Options

D PMIS Pogition Control D PMIS Position Distribution

DPMIS Pasition Control

[ JCYRMYR Flag [ contract Beg Date [Jpay Empld Pet [JExtra Duty Code

ition Mbr [ Contract End Date Pt of Year [ 5upplement Type

it D Payoff Date DPE‘- Concept D Supplement Max Amt
D"GD'DQ-’SC"H : [:|Base Suppl On Dly Rate
DA:! Hrly Dly Rate D Supplement Pay 1 Time

[]5alary Amount [Jpate Supplement 1 Time

D Occ Fay Type

D Suppl Recaloulate

D Ign Pct Day For Sal Calcs
[Jtan Pet ¥r For Sal Cales
[ Mew Employee

|:]I'K.-r. on School Year I Mbr Remain Payments I 3 Gﬁ::ost Change Midpoint Base
DF.':—:,encT |LJlab Catzgary DMB:\ Payments D Date Create/Update DPe'cmt of Midpaint
DG.'_: Employee Mbr D Supplement Attached DU-.-'.'.’ Elig Fig B Date Fill Duﬁe/‘"alc-,-me'.t Elig Flag
[ ]Primary Job ek Code [J5tate Minimum Days [JFill Pesition Reasen [JFica Elig

I’.:'ease Elig D 1st Pay Date Code DSaus' Position Mbr G Date Criteria D._-_lS Status Code

|J O Pay Grade D Calendar Cade DSavs* Billet Mbr D Drate Authorization DBch_: et Amount
DCL: Fay Step D Campus I DSupo.eme nt Extra Days D Date Authorization End DBng et Salary Override
[JOec Fay Schedule e [J5upet to Pos Mer [Joate Entry [O#cwaliBudget Ind
DSta:e Step Dl—rs Per Day DSJp-o.tc Pos Billet DDEte Inactive DPE‘- Type

DPMIS Position Distribution

[JCYRMNYR Flag [Jiek Code [JFunction [JEd Span [(JExpense 373
Dl"csi: on Mbr D;‘\ccsu nt Type D Object D Project Detail DC.:.ﬁ'.‘iI:- At Flag
DE Llet Nbr Df‘av Activity D Sub Object Dh‘.ccun: Ameount
Dr‘csizjn Type D'v‘.'c'ké's Comp D Organization D;*u'_:cun: Percent
[ vistribution Segquence OFte D [ Fiscal Year [ TRs Grant Code
DFreq_encT DFunc D Program Intent D Extra Duty Code

DEmplwae Demo

DMJG[;—N:.-“;— D-Ge'.era:ic'.

O Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

9. Update position records.

Position Management > Maintenance > PMIS Position Modify > Position Record

If necessary, update the Increase Eligible field to identify the employees who are eligible to
receive a salary increase for the new school year when running simulations. Only the employees
with this field selected will receive a salary increase.
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O Clear the Increase Eligible field for new employees who are not entitled to a salary
increase. Remember that the next year Position Management pay step reflects the same
current year Position Management pay step, and the step is increased in the salary simulations
if the Increase Eligible field is selected.
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POSTICN RECDRD DESTRIBUTION — DWTE BUDGET

Orxupant

— . .

Primary Jokc [] increase Elgile: [] New Employee:

Dy 0t [ 2] M D Emplvc 14300 Dy 7436.00 Pemaring Ponares: (T3] Bichute a
Poastian
b Coce: [1000 - TEACHER s ¢ D [ZJ! @ Primadery Campuan: [0 - 001 ey ]i Dest D
[ Ji e [ Ji t
¥ o Dl-_.- Y for . |:|

O If necessary, update the New Employee field to identify new employees on forecast position
records. If selected, the salary simulations will budget the employer contribution for new
employees even though they do not have current year payroll records.

Notes:
This field is not displayed on supplemental position records.

If the position is changed to any status other than Active, the field is disabled.

O Clear this field If an employee is no longer new to the LEA.

Position Management > Maintenance > PMIS Position Modify > Budget

If there are retirees who work in the LEA, confirm that the TRS Status field is set to 5 - Retired.
If the TRS status is incorrect, there is a possibility that the status will be incorrect (TRS-eligible)
when the employee is moved to the current year payroll.
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POSITION RECORD  DISTRIBUTION  DATE  BUDGET «

Vacancy/Budget Information
Pay Grade: |30 |: Pay StepfState Step: D Mon-Contracted emp  FTE:
Midpoint Base: Plus Percent of Midpoint 0.00
Unemployment Eligible: FICA/Medicare Eligible: [M - subject to medicare v | TRS Status: [" - Retired v]

Update NYR Positions and Move Employees to CYR Payroll

12-month Employees

11-month Employees

10-month Employees

Interface to Budget Checklist

Checklist
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